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If You Have Problems 

Please visit our service and support page at www.gamry.com/service-support/. This page contains infor-

mation on installation, software updates, and training. It also contains links to the latest available documen-

tation. If you are unable to locate the information you need from our website, you can contact us via email 

using the link provided on our website. Alternatively, you can contact us one of the following ways: 

 

 Internet  www.gamry.com/service-support/ 

Telephone (215) 682-9330   9:00 AM–5:00 PM, US Eastern Standard Time 

   (877) 367-4267, Toll Free US and Canada Only 

 

Please have your instrument model and serial numbers available, as well as any applicable software and 

firmware revisions.  

If you have problems in installation or use of a system containing Echem Analyst software, please try to call 

from a phone next to your computer, where you can type and read the screen while talking to us. 

We will be happy to provide a reasonable level of free support for registered users of the Echem Analyst 

software. Reasonable support includes telephone assistance covering the normal installation, use, and sim-

ple customization of a computerized system containing Echem Analyst software connected to a Windows
®
-

compatible computer. 

A service contract that extends the software update period is available at an additional charge. Software 

updates do not include software enhancements offered to our customers at additional cost. 

Enhancements to the Echem Analyst software that require significant engineering time on our part can be 

performed on a contract basis. Contact us with your requirements. 

Copyrights 

Echem Analyst™ Software Operator’s Guide copyright © 2008–2019, Gamry Instruments, Inc., all rights 

reserved. 

Framework copyright © 1989–2019, Gamry Instruments, Inc., all rights reserved. 

Framework and Gamry are trademarks of Gamry Instruments, Inc. 
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License Agreement 

Gamry Instruments, Inc. grants you, the Purchaser, a non-exclusive license to use the software programs included in 

this package, including updates which may later be provided by Gamry Instruments at additional cost. This license is 

subject to the terms and restrictions set forth in this Agreement. 

License 

The software programs and the Operator’s Manuals are protected by both United States copyright law and internation-

al treaty provisions. Accordingly, these software programs remain the property of Gamry Instruments, Inc. as its sole 

property, subject to the rights granted to you in this License Agreement. 

You may 

• Make archival copies of the software programs for backup purposes only. All backup copies must include the 

Gamry Instruments, Inc. copyright notice. 

• Transfer the programs and Gamry potentiostat from computer to computer within your facility. 

• Operate the data-acquisition (Framework™) and data-analysis portion (Echem Analyst™) of the programs on 

an unlimited number of computers within your facility. 

• Transfer the programs, with a copy of this license, to another party, provided the other party agrees to accept 

the terms and conditions of this Agreement. If you transfer the programs, you must at the same time transfer 

all copies of the programs to the same party or destroy any copies not transferred. If you transfer possession 

of any copy of the software programs, in whole or in part, to another party, your license is automatically ter-

minated. 

You may not 

• Sublicense, rent or lease the software programs. 

• Use this program with a potentiostat not specifically authorized by Gamry Instruments, Inc. 

• Modify the program and/or potentiostats to defeat the authorization code security scheme. 

• Reverse engineer, decompile, or disassemble any program module or programmable logic device. 

• Copy, use, modify, or transfer the software programs or Operator’s Manuals or any copy, in whole or in part, 

except as expressly provided in this Agreement. 

Term 

This license is effective until terminated. You may terminate it by destroying or returning the programs and Operator’s 

Manuals and any copies thereof. This license will terminate if you fail to comply with any term or condition of this 

Agreement. 

Governing Law 

1. This License Agreement shall be governed by the laws of the Commonwealth of Pennsylvania. If any provision of 

this License Agreement is found void, invalid, or unenforceable, it will not affect the other terms and conditions of this 

Agreement, which remain valid and enforceable. 

Third-Party / Use Sublicenses 

2. Gamry software may incorporate Third-Party or Use Sublicenses (such as Microsoft VBA). In this case, the terms 

and conditions of their License Agreements (available during Setup) will apply. 

Disclaimers 

Gamry Instruments, Inc. cannot guarantee that the Echem Analyst software will work with all computer 

systems, operating systems, and third-party software applications, hardware, or software. 

The information in this guide has been carefully checked and is believed to be accurate as of the time of 

release. However, Gamry Instruments, Inc. assumes no responsibility for errors that might appear. 

No part of this document may be copied or reproduced in any form without the prior written consent of 

Gamry Instruments, Inc. 

Windows®, Excel®, and Powerpoint® are registered trademarks of Microsoft Corporation. Origin® is a 

registered trademark of OriginLab Corporation. DigiSim® is a registered trademark of Bioanalytical Sys-

tems, Inc. 
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Introduction to This Guide 

Echem Analyst™ software is Gamry Instruments’ dedicated data-analysis program, the 

companion to Gamry Instruments’ data-acquisition program called Framework™. Data 

files generated by experiments in Framework software then can be analyzed in the 

Echem Analyst. The Echem Analyst is a single program that runs data-analysis for all types 

of experiments, such as those used in DC Corrosion, EIS, and Physical Electrochemistry. 

 

The Echem Analyst is designed with the specific functions to make data analysis as 

straightforward as possible. This manual explains the most common analysis routines. The 

tools discussed here in the examples are common to many data files created by other 

experiments. This document is a guide, and is not intended to have the same scope as 

the on-line help or a complete operating manual. In order to create a concise document, 

we assume you have a working knowledge of Windows
®

-based applications. We ignore 

details about common functions, such as opening, saving, and closing files, so as not to 

obscure the goal of this guide. 

 

This textbox indicates a helpful hint to know about Echem Analyst. 
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General Information and Overview 

Installation 

Echem Analyst installs separately from other Gamry software. If Echem Analyst is 

not installed yet, you can find it on the CD-ROM, or—if you already own one of 

our potentiostats—on our website at www.gamry.com. 

 

You may install copies of the Echem Analyst on multiple computers. Often users 

prefer the convenience of performing data-analysis at an office workstation, rather 

than the laboratory setting. 

 

File Formats 

Gamry data files acquired using Framework software have the extension *.DTA. 

DTA files are ASCII text, and therefore you can open them directly into various 

programs, such as Excel
®

 or Origin
®

. When DTA files are opened in Echem Ana-

lyst, then saved, their extension becomes *.GData. Gdata (Gamry Data) files in-

clude information on curve-fits and graphing options, thus Gdata files are only 

viewable in Echem Analyst. 

 

 

 

 

 

 

To Open a Gamry Data File 

There are several different methods to open data files in the Echem Analyst: 

3. Launch the Echem Analyst icon on your desktop. Then use the File 

> Open function. 

4. Use the link on your desktop to open the My Gamry Data folder. 

Double-click on the data file. You may have to instruct your com-

puter to associate the *.DTA extension with the Echem Analyst 

program. 

5. There are two quick ways to open a recent Gamry Data File. 

a. A recently generated file can be opened using the hotlink in the Analysis menu in the 

Gamry Framework. (The last eight generated data files are listed there for quick access.) 

The Echem Analyst automatically launches and opens your selected data file. 

b. A recently opened file in the Echem Analyst is shown at the bottom of the File menu. This 

is similar to how other Windows
®
-based programs display links to Most Recently Used 

documents. 

 

 Do not delete your DTA files! They are the raw data and may need 

to be reloaded for certain analyses, such as area normalization. 

http://www.gamry.com/
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 Don’t change the directory for Analysis Script Files. These are the 

VBA programs that do the actual analysis. 

By default, files acquired in the Framework are saved into the My Gamry Data 

folder. A shortcut for My Gamry Data installs on the Windows
®

 desktop. You can 

change this default under Tools > Options, which opens the Gamry Analysis 

Framework Options window. Choose the General tab, and change the Path for 

each type of data file as desired. 

 

The data set appears in the main window. The menu items, tabs, and toolbar are 

adjusted for the particular type of data set you chose. In the example below, a Po-

tentiostatic EIS data set is shown: 

 

Note the tab-based display. The Experimental Setup tab displays all the infor-

mation from the parameters used to run the experiment, such as voltage, time, 

etc. The Experimental Notes tab stores any notes written into the setup screen in 

Framework. The Open Circuit Voltage tab shows the voltage measured during 

the initial delay of the experiment. The Hardware Settings tab records infor-

mation on the filters, ranges, gains. Additional information on date of last calibra-

tion, software version, etc. is also stored here.
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Working with Plots in Echem Analyst 

Introduction 

Echem Analyst boasts a number of graphical tools to help you get the most infor-

mation out of your data. After you open a data set, these tools appear in the 

toolbars immediately above the plot: 

 

In the data file, Framework writes a line that indicates the type of experiment 

used to generate that file. Echem Analyst displays both general and specific menus 

containing the analysis routines pertinent to your experiment. 

 

Toolbars: 

 

The main toolbars are: 

 

General 

Toolbar 

General functions for replotting and printing in various formats 

 

Selection 

Toolbar 

Tools to select and view data points 
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The following charts are references for buttons on the default toolbars. Descrip-

tions of the most commonly used functions are highlighted in blue. 

 

General Toolbar Functions 

Button Name Action 

 

Copy to clip-

board 

Copy the selection to the Windows
®
 clipboard. Can paste directly in Mi-

crosoft programs for reports or presentations. 

 

Gallery Choose, via the dropdown menu, from scatter (no line), line, curve, and 

steps between data points 

 

Color Choose the color of the selection from the dropdown menu. To change the 

color menu, use the Palette button on the PaletteBar. 

 

Vertical Grid Toggle between showing and hiding vertical grid lines on the plot 

 

Horizontal 

Grid 

Toggle between showing and hiding horizontal grid lines on the plot 

 

Legend Bar Toggle between showing and hiding a legend bar underneath the plot 

 

Data Viewer Toggle between showing and hiding numerical data to the left of the plot 

 

Properties… Open the GamryChart Properties window, so that you can adjust effects, 

colors, markers, 3-D effects, lines, etc. 

 

3D/2D Toggle between two-dimensional and three-dimensional graphing 

 

Rotate Rotate the three-dimensional graph. Only active if the graph is 3D. 

 

Z-clustered Offset two data sets so that they can be distinguished within one plot. 

Only operates in 3D mode. 

 

Zoom Zoom in on a selected region. Also open a zoom slider at the bottom of the 

graph for continuous adjustment of zoom. 

 

Print preview Open the Page setup window to adjust orientation of plot and printer mar-

gins 

 

Print Print the plot 

 

Tools Open a dropdown menu, for choices of various toolbars and viewers to 

appear on the screen 
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Selection Toolbar Functions 

Button Name Action 

 

Show curve selector Open the Curve Selector area to the right of the plot, so that you 

can choose which data are used as the x-, y-, or y2-coordinate, and 

which curve is the active trace. 

 

Select x region Select a desired region of the plot across the x-axis. Commonly used 

to specify a region for Quick-Integrate. 

 

Select y region Select a desired region of the plot across the y-axis Commonly used 

to specify a region for Quick-Integrate. 

 

Select Portion of 

Curve using the 

Mouse 

Left-click on the active trace using the mouse to select a section of 

the curve 

 

Select Portion of 

Curve using the Key-

board 

Open an area to the right of the plot, in which you can choose a 

segment of the trace numerically. See below for more details. 

 

Draw Freehand Line Draw a line on the plot 

 

Mark Found Peaks Place a tag on peaks that the software finds. A portion of the curve 

must be selected first. 

 

Apply Template Open the Apply User-Defined Chart Template window, and 

choose a previously created template to apply to the plot 

 

Save Template Open the Save User-Defined Chart Template window, and save 

the template 

 

Show Disabled Points Show data points not being used in the plot 
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 If there is a data column graphed on the Y2-Axis, those data appear in 

a different color and a different scale. 

 

Changing the Axes on a Plot (the Curve Selector): 

To choose a different variable plotted on an axis, use the Curve Selector button 

 as follows:  

(The example shown below is a Differential Pulse Voltammetry plot.) 

 

1. With the plot open and displayed on the screen, click the Curve Selector but-

ton . 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Curve Selector area appears on the right side of the window. 

2. Choose which trace is active by clicking the drop-down menu in the Active 

Trace area. 

The Active Trace is the data series on which the analysis will be performed. 

Use this if multiple files or cycles are displayed on the graph. 

3. Choose which trace is visible on the plot by activating the checkbox next to the 

desired trace(s) in the Visible Traces area. 

Visible Traces also contains any data fits that are performed. 

4. Choose which variable is plotted on the x-axis by highlighting the variable in 

the X-Axis column. 

5. Choose which variable is plotted on the y-axis by highlighting the variable in 

the Y-Axis column. 

6. Choose which variable is plotted on the second y-axis by highlighting the vari-

able in the Y2-Axis column.  
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Selecting Portions of a Curve for Analysis 

For certain types of analysis, you must select a region of the curve, for example, 

within the Peak Find function in Cyclic Voltammetry or Tafel Fit function in Po-

tentiodynamic. You can select regions by mouse or keyboard. 

1. Left-click the mouse on the Mouse button  in the Selection toolbar. 

2. Use the left mouse-button to select each endpoint of the curve. 

Each endpoint is marked with a blue cross. The selected portion of the curve 

is shown as a thick blue line. (In the figure below, the color of the data was 

changed to red for contrast to the selected region). 

 

 

3. Another click on the Mouse button clears the selected region, and readies the 

graph for a different region to be selected.  
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 If you are using the As Text feature, be sure to note the currently 

graphed parameters. The coordinates of this currently displayed graph are cop-

ied and can be pasted to graphing programs. 

 Bitmap is not an editable format. 

Cutting and Pasting Images and Data 

Many users want to present, publish, or otherwise share their data and charts 

from the Echem Analyst. 

To create a bitmap image of the graph, 

 

As a Bitmap: 

1. In the General Toolbar, click the Copy to Clipboard button . 

2. In the drop-down menu select As a Bitmap.  

 

3. A bitmap image of the graph enters the clipboard. You can paste this bitmap 

into a presentation program such as Word
®

 or Powerpoint
®

. 

 

This is a quick and easy way to 

import a picture of the graph for 

a presentation or report. 

 

As Text: 

Because Gamry Data Files are ASCII text, they can be opened easily in other gra-

phing programs, such as Excel
®

 or Origin
®

. Right-click on the DTA file, select 

Open With…, and select your desired program. These programs, however, do 

not contain fitting routines specific to the analysis of electrochemical data. This As 

Text feature lets you fit the data in Echem Analyst and then copy and paste the 

data and fit into another graphing program. 

 

This is a quick and easy way to import both the data and the fit into another gra-

phing program.  
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Plotting Conventions 

By right-clicking the mouse on a non-zero value on an axis, you can choose to 

show that axis in Log Scale (logarithmic) or linear scale (when Log Scale is inac-

tive), or to reverse the direction of the numbers (when Reversed is active).  

 

Or you can use the Transform Axes selection (if available) under the Common 

Tools menu. 

 

 Default plotting of graphs is auto-scale. Therefore, note the y-axis‘s 

scale when a plot first appears.  If bad data points obscure your data because 

of auto-scaling, you can choose to disable and hide those offending points. 
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Getting On-Line Help and Version Number: 

In the toolbar, choose Help. 

a. Click Gamry Help to obtain infor-

mation about various commands 

and functions within Echem Analyst. 

 

A separate Gamry Echem Analyst Help 

window appears. You can find much infor-

mation about the details of Echem Analyst here, such as plotting and analysis. 

 

 

 

b. Click About the Gamry Echem Analyst to view the software version number. 

 

 On-line help is a great resource for more involved questions. Help 

is divided up according to software package.  
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Common Tools and Tabs 

 

While each type of experimental data has its own method and parameters, there 

are certain commands that are common to many analyses. This section shows you 

these Common Tools. 

 

Accessing Common Tools 

1. Open a dataset. 

In the toolbar, the function Common Tools appears. 

2. Choose 

Com-

mon 

Tools. 

A drop-

down 

menu 

appears. 

3. Select the desired command. 

In this example, chronoamperometry’s Common Tools includes three com-

mands: Add I Constant, Linear Fit, and Smooth Data. 

 

List of Common Tools 

Command Type of experiment Result 

Add E Con-

stant 

Cyclic Voltammetry, DC Voltammetry, Dif-

ferential Pulse Voltammetry, Galvanic Corro-

sion, Normal Pulse Voltammetry, Pitting 

Scan, Polarization Resistance, Potentiody-

namic Scan, Square-Wave Voltammetry 

Adds a constant po-

tential to all voltages 

in the plot. Used to 

easily convert be-

tween different Ref-

erence Electrode’s 

scales. 

Add I Con-

stant 

Chronoamperometry, Chronopotentiometry, 

Cyclic Voltammetry, Galvanic Corrosion, Pit-

ting Scan, Polarization Resistance, Poten-

tiodynamic Scan 

Adds a constant val-

ue to all currents in 

the plot. 

C from CPE, 

omega(max) 

Potentiostatic EIS, AC Voltammetry, Mott-

Schottky 

Calculates capaci-

tance from previ-

ously fit CPE values 

 The list of Common Tools varies depending upon the type of experi-

ment. 
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and data from the 

Nyquist plot. 

C from CPE, 

R(parallel) 

Potentiostatic EIS, AC Voltammetry, Mott-

Schottky 

Calculates capaci-

tance from previ-

ously fit CPE and fit 

R data. 

Linear Fit Chronoamperometry, Potentiostatic EIS, AC 

Voltammetry, Chronocoulometry, Chronopo-

tentiometry, Cyclic Voltammetry, DC Volt-

ammetry, Differential Pulse Voltammetry, 

EMF Trend, Galvanic Corrosion, Mott-

Schottky, Normal Pulse Voltammetry, Polari-

zation Resistance, Potentiodynamic Scan, 

Square-Wave Voltammetry 

When a region of 

the plot is selected, 

fits the data to 

y = mx + b. 

Post-Run iR 

Correction 

Cyclic Voltammetry, Polarization Resistance, 

Potentiodynamic Scan 

Corrects a previous-

ly run scan for volt-

age-drop caused by 

iR. 

Smooth Data Chronoamperometry, Chronopotentiometry, 

Cyclic Voltammetry, DC Voltammetry, Dif-

ferential Pulse Voltammetry, EMF Trend, 

Galvanic Corrosion, Normal Pulse Voltamme-

try, Pitting Scan, Polarization Resistance, Po-

tentiodynamic Scan, Square-Wave Voltam-

metry 

Smooths the data. 

Useful for locating 

peaks in regions of 

high data-density. 

Transform 

Axes 

Galvanic Corrosion, Pitting Scan, Polarization 

Resistance, Potentiodynamic Scan 

Changes x- and y-

axes from linear to 

logarithmic, etc. 
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Experimental Setup 

 

This particular Experimental Setup tab is from a Cyclic Voltammetry experiment. This 

example has many of the same parameters as other experiments. It shows: 

 

Initial E, Scan Limit 1, Scan 

Limit 2, Final E 

The potentials defining the waveform, and whether measured vs. a refer-

ence electrode (Eref) or the open circuit potential (Eoc). 

Test Identifier Read from the Framework Setup. This field also becomes the default title of 

the plot. 

Time Time the experiment was started 

Scan Rate How fast (in mV/s) the scan was taken 

Step Size The interval between potentials 

Electrode Area The size of the electrode 

Equil. Time How much time was spent letting the electronics settle before the scan was 

started 

I/E Range Mode Automatically adjusted or fixed I/E (Current) Range mode. 

Max Current The current value that sets the I/E Range in Fixed Mode and determines the 

range in which to start in Auto Mode 

Conditioning Whether off or on, for how long, and under what potential. This Potential is 

vs. Reference. 

Init. Delay Whether off or on. This is when the Eoc is measured. 

Cycles Number of how many voltammetry cycles were run 

IR Comp If IR Compensation was used and the mode. 

Open Circuit The value of the open-circuit voltage (Corrosion Potential). It is the value of 

the last point in the Initial Delay. 

Sampling Mode Data-acquisition mode (for Reference family Potentiostats) 
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Experimental Notes 

Click the Experimental Notes tab: 

Any notes entered in the Framework software are automatically displayed 

here. You may enter any additional comments about the experiment in the 

Notes… field. 

This is a version of a modern laboratory notebook. Enter as many details about 

your experiment as you can. Information here can help you avoid having long 

strings of descriptive file names. 
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Hardware Settings 

Click the Hardware Settings tab: 

 

 

 

 

 

 

 

 

 

The hardware set-

tings displayed here 

are: 

 

Potentiostat Shows the potentiostat’s label 

Control Mode How the experiment was controlled 

Control Amp Speed Shows the speed of the control amplifier 

I/E AutoRange Shows if the I/E autorange function was enabled 

Ich AutoRange Shows if the Ich autorange function was enabled 

Ich Range Shows the I
ch

 range (gain). 3 volts = ×1 Gain. 

Ich Filter Shows the Ich cut-off filter frequency 

Ich Offset Enable Shows if Ich Offset was enabled 

Ich Offset Shows the I
ch

 offset voltage 

Positive Feedback IR 

Comp 

Shows if the IR positive feedback was enabled 

I/E Range Lower Limit Shows the lowest available I/E Range available to use in this experiment 

Ach select Shows the input connector for Ach 

DC Calibration Date Shows the date of last DC calibration 

Framework Version  

Pstat Model Gives the model number of the potentiostat 

 This section documents the hardware settings that were used when 

the experiment was run, e.g., everything from the offsets, filters, and gains to 

the last time the potentiostat was calibrated. 

 

This information is used primarily by Gamry Instruments’ Technical Support 

staff to help troubleshoot. Gamry Instruments determines default settings based 

on experience. Advanced users can adjust these settings manually before the 

experiment is run. 

 

For DC Corrosion experiments, the Hardware Settings are set in the experi-

ment code. For Physical Electrochemistry experiments, you have access to 

these features through the Advanced Panel, but we recommend that only ad-

vanced users make changes to these settings. Consult Help or Gamry Instru-

ments’ Technical Support for advice. 
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Current Convention Shows which currents are positive 

I/E Stability Shows the I/E stability speed 

I/E Range Shows the I/E (or current) range used 

Vch AutoRange Shows if Vch autoranging is enabled 

Vch Range Shows the maximum value for Vch 

Vch Filter Shows the Vch cut-off filter frequency 

Vch Offset Enable Shows if Vch Offset was enabled 

Vch Offset Shows the Ich offset voltage 

Positive Feedback Re-

sistance 

Shows the positive feedback resistance applied to the system 

Ach Range Shows the voltage range of the auxiliary channel 

Cable ID (for Reference family potentiostats only.) Gives the type of cable connect-

ed to the system 

AC Calibration Date Shows the date of last AC calibration 

Instrument Version Shows the Firmware Version of a Reference family potentiostat  

Detailed explanations of these parameters are beyond the scope of this guide. 
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Open Circuit Voltage (Corrosion Potential) Data 

Click the Open Circuit Voltage tab: 

 

 

 

 

 

  Because default plotting of graphs is auto-scale, please note the 

y-axis‘s scale when the Open Circuit Voltage first appears. 
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Analysis of Cyclic Voltammetry Data 

This is a sample cyclic voltammetry file that installs in \My Gamry Data\ when 

Framework software installs.  

 

Cyclic Voltammetry Special Tools 

This menu analyzes the cyclic voltammetry data. 

1. In the main menu, choose Cyclic Voltammetry. 

A drop-down menu 

appears. 

2. Choose the desired 

tool: 
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Tool Function Notes 

Min/Max Finds the minimum and maximum currents and 

voltages within the dataset. Results appear in a win-

dow below the plot. 

 

Quick Integrate Integrates to find the total charge. Results appear in 

a window below the plot. 

For multi-cycle CV 

experiments 

Integrate Integrates over a specified portion of the plot to find 

the total charge. 

Portion of the curve 

must be selected 

Region Baselines Defines a line as the baseline for a specified region. Region must be se-

lected 

Clear Regions Clears all baselines from the dataset. Region must be se-

lected 

Normalize by Scan 

Rate 

Normalizes the dataset based on the scan rate.  

Normalize by Square 

Root of the Scan Rate 

Normalizes the dataset based on the square-root of 

the scan rate. 

 

Peak Find Finds peaks within a specified region of the dataset. Portion of the curve 

must be selected 

Clear Peaks Clears all peaks found within the dataset. Peaks must be identi-

fied 

Automatic Baseline Finds the baseline automatically. Peaks must be identi-

fied 

Peak Baselines Defines a line as a baseline for a specified peak. Peaks must be identi-

fied 

Clear Lines Clears all lines from the dataset. Lines must be associ-

ated with graph 

Delta Ep Finds the potential difference between two peaks. Peaks must be identi-

fied 

Subtract Background 

from File 

Subtracts a background amount from the dataset.  

Export to DigiElch Exports the file to a DigiElch
-
compatible

 
format.  

Options Changes units and grids for plotting the data.  
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Integrating the Voltammogram 

All integration methods integrate current versus time to get the total charge. There 

are two different ways to integrate under a curve with Echem Analyst. 

 

Quick Integrate 

Quick Integrate breaks the data into “curves.” Each curve is integrated to a zero 

current. Quick Integrate integrates the entire area of each curve, unless an area is 

specified using the x-region icon. 

 

Integrate 

Integrate requires you first to select a portion of the curve. (See how to select a 

portion of the curve in the “Starting Echem Analyst” chapter.) After an integration 

is performed, you can change the baseline from the default 0 A to another line, 

either a line that you draw, or an Automatic Baseline. 

3. Open the data file. 

1. Select the Draw a Freehand 

Line button. 

 

 

2. Left-click and hold on the graph 

to place an anchor point. Hold-

ing down the mouse button, ex-

tend the line with the mouse. 

Move or extend the line as you 

wish. 

Directions to accept the 

line are printed at the 

bottom of the window. 

3. Right-click the mouse on 

the line and either Ac-

cept or Delete. 

After you accept the 

line, it turns from 

dashed to solid. 

4. Select the portion of the 

curve to integrate. 

This function is de-

scribed in detail earlier. 
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5. Select Integrate from 

the Cyclic Voltammetry 

menu. 

This integrates the sec-

tion between the curve 

and the zero A line. 

6. To change the baseline 

to the desired user-

drawn line, select Re-

gion Baselines from the 

Cyclic Voltammetry 

menu. 

The Region Baseline Set-

tings window appears. 

7. Select the desired Baseline 

from the available lines. You 

may draw multiple lines from 

which to choose. 

The integrated 

region moves 

from the de-

fault 0 A base-

line to the us-

er-drawn line.  
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Modeling Polarization Resistance Data 

Polarization Resistance Special Tools 

This menu analyzes the polarization resistance data. 

1. In the main menu, choose Polarization Resistance. 

A drop-

down 

menu 

appears. 

 

 

 

2. Choose the desired tool: 

Tool function 

Quick Integrate Integrates to find the total charge. Results appear in a window below the plot. 

Min/Max Finds the minimum and maximum currents and voltages within the dataset. Re-

sults appear in a window below the plot. 

Polarization Re-

sistance 

Within a selected portion of the curve, finds the polarization resistance. 

Options Changes units and grids for plotting the data. 

 

Finding the Polarization Resistance 

Method 1: Manual Entry of the Tafel Constants 

1. Select the desired portion of the curve. (See section “Selecting Portions of a 

Curve for Analysis”) 

2. In the main menu, choose Polarization Resistance. 

A drop-

down 

menu 

appears. 

 

 

 

3. Choose Polarization Resistance. 

The Polarization Resistance window 

opens. 

4. In the Seed Values area, enter anodic 

(Beta A) and cathodic (Beta C) Tafel con-

stants. 

5. Click the Calculate button. 

The calculated Corrosion Rate appears 

in a window below the plot. 
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Method 2: Automatic Selection of Voltage Region 

Echem Analyst offers another way to select automatically the voltage region over 

which this analysis is done. 

1. In the Polarization Resistance menu, choose Options.  

 

 

 

 

 

 

 

The Polarization Resistance Options window opens. 

2. Select the Automatic radio 

button, specify the region 

around Ecorr to use, and 

click the Save as Defaults 

button. You are prompted 

directly for Tafel constants 

when a polarization re-

sistance file is opened. 

 

This is how Gamry Instru-

ments’ RpEc Trend experi-

ments calculate corrosion rate. 
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Modeling Potentiodynamic (Tafel) Data 

A Tafel experiment is also a very popular electrochemical corrosion technique. 

The following analysis is performed on the sample Potentiodynamic data file. 

Tafel Fit 

3. Select the region over which to perform the Tafel fit. 

This region must encompass the Ecorr (open-circuit potential). 

4. Select Tafel Fit from the Potentiodynamic menu: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. A Tafel Fit window appears where you may 

input seed values optionally for the fit. 

The better the information we provide the 

fitting routine, the more likely it will be able 

to generate an acceptable fit. 

 

If you have reasonable starting parameters 

for the fit, input them in the Seed Values 

area, and check the Use Seed Values 

checkbox. If you do not have any confi-

dence at all in your range of parameters, do 

not check the Use Seed Values checkbox. 

 

We recommend using the seed values sup-

plied by the Echem Analyst. 

 

2. Click the Calculate button. 

When you click the Calculate button, the changes can be subtle. The follow-

ing events occur: 

• The parameters in the Tafel Fit window become the fit parameters. 

• A fit line is displayed on the graph. 
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• A new Tafel tab is created (to the right of the Hardware Settings tab) that 

holds the information about the fit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

E Log I Fit 

The E Log I fit is a useful fit if you want to fit the data one branch (anodic or ca-

thodic) at a time. This can be important if one branch doesn’t show linear behav-

ior, but the other does. 

 

The fit is called E Log I because of the semi-logarithmic nature of a Tafel plot. The 

x-axis is the logarithm of current, while the y-axis is potential on a linear scale. 

Method 

5. Select a portion of the curve. 

Here you need only the linear section of one of the 

branches. This selection does not include Ecorr 

[Eoc (open-circuit potential)]. 

1. In the E Log I Fit window, enter an approximate 

value for Ecorr. 

2. Click the Calculate button. 

A single branch of the Tafel 

data is fit. The fit is shown 

on the graph, and the results 

of the fit are contained in a 

new E Log I tab. 

 

You can run a Polarization 

Resistance fit on these Po-

tentiodynamic data, if the 

axes of current are changed 

to the linear scale. Generally 

we suggest running a separate experiment on a new sample of the same mate-

rial because of the more-polarizing, more-destructive nature of the Poten-

tiodynamic experiment. 
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Modeling EIS Data 

The data-analysis features shown here are common to many of the AC-based 

techniques. By far the most popular type of AC experiment is Potentiostatic EIS. 

 

Bode and Nyquist Plot View 

Click the Bode tab or the Nyquist tab of the plot you prefer to work with. All fits 

are displayed on both the Bode and Nyquist plots. Because they are different rep-

resentations of the same data, the fit results are identical. 

 

 

 

Bode plot 

Nyquist plot 
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EIS Special Tools 

EIS data-analysis uses an equivalent-circuit approach. This menu creates and runs 

fits for EIS data. Commands in this menu allow you to build an equivalent-circuit 

model in the Model Editor, then fit that model to your data. This menu also lets 

you run advanced procedures, such as Subtract Impedance, and run Kramers-

Kronig transforms. 

6. In the main menu, choose Impedance. 

A drop-down menu appears. 

7. To create 

or edit an 

equivalent 

circuit, 

choose 

Model Edi-

tor. 

The Im-

pedance 

Model Ed-

itor win-

dow appears. See the next page for how to use it. 

1. Choose your fitting method. 

o To fit the data using the Levenberg-Marquardt method, choose Fit A Mod-

el (Levenberg-Marquardt Method). 

▪ The Select Model File window opens. 

▪ Choose the appropriate model file, and click the OK button. 

o To fit the data using the Simplex method, choose Fit A Model (Simplex 

Method).  

▪ Simplex method weighs the user’s seed values less. We recommend 

using the Simplex method. 

2. To subtract an impedance from the data, choose Subtract Impedance…. 

The Impedance Subtraction window appears. 

Choose: 

Element Choose a circuit element from the drop-down menu. 

Model Browse for a previously defined model. 

Spectrum Browse for a data-set. 

Click the Close button. 

3. To use the Kramers-Kronig method, choose Kramers-Kronig. 

Kramers-Kronig is a model-independent transform that checks the EIS data for 

consistency. 

The Kramers-Kronig window appears. 

4. To clear all fits from the plot, choose Clear All Fits. 

5. To change time or impedance units, choose Options. 

This option let you normalize the data and fits to the normalized area. 
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The Model Editor 

The Impedance Model Editor allows you to create an equivalent circuit, via a 

drag-and-drop method. 

 

Circuit Elements 

Symbol Element Comments 

 

Resistor Abbreviated as R. Z = R 

 

Capacitor Abbreviated as C. Z = –i/C 

 

Inductor Abbreviated as L. Z = iL 

 

Constant Phase 

Element 

Models an inhomogeneous property of the system, or a property with a 

distribution of values. Often abbreviated as CPE. 

 

Wire Connects one element to the next. 

 

Gerischer ele-

ment 

Models a reaction in the surrounding solution that happened already; also 

used for modeling a porous electrode. Often abbreviated as G. 

 

Infinite War-

burg 

Models a linear diffusion to an infinite planar electrode. Often abbreviated 

as W. 

 

Bounded War-

burg 

Models diffusion within a thin layer of electrolyte, such as electrolyte 

trapped between a flat electrode and a glass microscope slide. Often ab-

breviated as T. 

 

Porous Bound-

ed Warburg 

Models diffusion through a thin layer of electrolyte, such as electrolyte 

trapped between an electrode and a permeable membrane covering it. 

Often abbreviated as O. 

  

Bisquert Open 

(BTO) 

Transmission line with ZB ≡ ∞ boundary condition. Only pore reactions 

are considered; base electrode is insulating. 

 

Bisquert Short 

(BTS) 

Transmission line with ZB ≡ 0 boundary condition. Only pore reactions are 

considered; electrode is non-insulating. 

 

Unified (UTL) Transmission line with a variety of free parameters. 

 

 There 

are several pre-

loaded models. Of-

ten users find it con-

venient to start with 

one of these models 

and edit it as need-

ed. 
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Building an Equivalent Circuit 

1. Adding an element 

a. Click on an element symbol. 

The element appears in the central window. 

b. Place the mouse cursor over the element. Left-click and drag to move the element to its 

desired position. 

2. Connecting elements 

a. Click on the Wire symbol . 

b. Left-click one end of the wire and drag the 

end to the element. 

The element’s border turns green when the wire’s 

end reaches the element. 

3. Deleting an element 

a. Right-click on the element. 

The Delete command  appears. 

b. Left-click on the Delete command. 

The element vanishes. 

Here is an example of a simple equivalent circuit (a Randles model) constructed 

in the Impedance Model Editor: 

 

 

 

 

 

 

 

4. Relabeling and fixing parame-

ters for an element 

This lets you rename the element, and 

specify a Lower and Upper Limit for its 

value. Renaming the element helps you 

distinguish between elements of the 

same type during fitting. Giving the program limits on the parameters may help the mathematical 

algorithm. For example, we know values are generally positive, so a Lower Limit = 0 is reasonable 

to set. 

a. Left-click on the name of the el-

ement (here, R1). 

The Parameter window appears. 

b. Enter a new Parameter Name. 

c. Enter an Initial Value, i.e., the 

first trial value for fitting. 

d. In the Lower Limit Test and 

Upper Limit Test fields, enter 

lower and upper limits, and 

check the Enable checkbox, as 

desired. 

e. Click the OK button. 

The Parameter window closes, and the 

element is set to these parameters. 

 

 Be sure to connect 

the circuit to the reference-

electrode symbol  and the 

working-electrode symbol . 
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Compiling the Equivalent Circuit 

When the equivalent circuit is complete, the circuit can be compiled before use 

to check for connectivity of the wires. Compiling is only used to check connec-

tions 

1. Click the Test Compile button  in the toolbar. 

The software compiles the equivalent circuit. 

If there is a problem, such as a missing connection, an 

error message appears, and a red box outlines the problem element: 

2. Click the OK button to continue. 

3. Inspect the schematic and make necessary 

corrections. 

 

 

If the equivalent circuit compiles properly, 

the Model Editor win-

dow appears: 

4. Click the OK button to 

continue. 

5. Save the equivalent circuit 

with a *.mdl extension 

by clicking the Save but-

ton . 

 

The File Save As window appears. 

The default folder for saving 

model equivalent circuits is 

the Models folder. 

6. Name and save the file here, 

or choose a different folder. 

The model shown above 

was saved as trial mod-

el.mdl. 

The File Save As window 

closes. 
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Fitting the Data to the Equivalent-Circuit Model 

1. With the data open and 

plotted, click Imped-

ance, and choose Fit A 

Model (Simplex Meth-

od). 

The Select Model File 

window appears. 

2. Choose the desired 

model. 

The default folder for models is the Models folder. This Models folder is in 

the C:\Documents and Settings\All Users\Application Da-

ta\Gamry In-

struments\Echem 

Analyst\Models  

by default. As our ex-

ample, we choose the 

model trial mod-

el.mdl created pre-

viously.  

 

 

 

 

 

3. Click the Open but-

ton. 

The Select Model File window closes, and the Impedance Fit by the Simplex 

Method window appears.  

4. Click the AutoFit 

button, or set pa-

rameters.  

When setting pa-

rameters, choose 

the Maximum It-

erations to loop 

before stopping the 

fit. Enter estimates 

for all the circuit 

elements in the 

Model Parameters 

area. Fix particular 

elements by ena-

bling their Lock checkboxes. 

In our example, we try 100 Ω for Ru, 2500 Ω for Rp, and 100 nF for Cf and 

leave all of them free (unlocked). 
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 If your 

fit fails, try different 

starting Model Pa-

rameters, or even 

a different equiva-

lent-circuit model. 

5. If you don’t use the AutoFit button, click the Calculate button to start the fit. 

The software attempts to fit the model to the data. When finished, the fitted 

parameters appear next to each circuit element.  

Our model results give 

Rp = 3 kΩ 

Rsolution = 199.7 Ω 

Cf = 980 nF  

 

Like other Echem Analyst fits, the fit also appears superimposed upon the data 

and a new tab is created that contains those results.  

 

If you try another fit using the same model, this fit will be overwritten. If you fit to 

another model, the fit results of both models will be displayed. 
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This new tab shows the residual errors and goodness of fit, along with the various 

plotting tools. Residuals are a point-by-point Goodness of Fit, which quantifies 

how closely the data match the fit. A smaller number indicates a better fit. 

 

The blue data (Zreal) correspond to the y1-axis (on the left); the green data (Zim-

ag) correspond to the y2-axis (on the right). 
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Appendix 

Headings in Data-File Columns 

DC Data Files 

Abbreviation Meaning 

Pt Point number 

T Time 

Vm, Vf Measured voltage 

Im Measured current 

Vu Uncompensated voltage 

Sig Signal from the signal generator 

Ach Auxiliary channel 

IE Range I/E (Current Measurement) range on which measurement was made 

Over Any overloads. Numeric record of different overload types  

0 No overloads  

 

EIS Data Files 

Abbreviation Meaning 

Freq Frequency 

Zreal, Zimag, Zmod, Zphz Calculated values of impedance 

Idc, Vdc DC component of current and voltage, 

Yreal, Yimag Admittance (calculated from Z) 
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Current Conventions According to Framework™ and 

Echem Analyst 

The current convention in the Framework software for all experimental packages 

is that an anodic/oxidation current is positive. 

 

To change the current convention (whether anodic/oxidation currents or cathod-

ic/reduction currents are positive), in the menu Tools > Options > Units tab, 

specify the current you want represented as positive. The current convention can 

be changed by editing the experimental script (contact Gamry Instruments or your 

Gamry Instruments representative if you need to do this). Regardless of the cur-

rent convention used in the Framework, it can be changed in the Echem Analyst 

to the one you desire (see below for exceptions). 

 

To change the current convention in the Echem Analyst, in the menu Tools > 

Options > Units tab specify the current you want represented as positive.  

 

To change the current convention in other experimental packages (DC Corrosion, 

EIS, etc.) please contact Gamry Instruments or your Gamry Instruments repre-

sentative. 

 

To Edit Visual Basic Scripts: 

1. In the toolbar, choose Tools.. 

A drop-down menu appears. 

 

 

 

 

 

 The current convention affects all experiments run under the Phys-

ical Electrochemistry and Pulse Voltammetry heading. No other data files are 

affected. 

Echem Analyst runs on “Open Source” 

scripts written in VBA. Most customized analysis rou-

tines are done by Gamry Instruments in the factory for 

you, the user, and that makes Echem Analyst extremely 

flexible. The typical user will never need to edit the 

scripts for electrochemical analysis.  
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Simulating an EIS Curve 

It is often useful to simulate the response of an equivalent circuit.  

1. Launch the Echem Analyst. 

2. Select Tools > Run Named Script. Select EIS Model Simulation 

Script.Gscript. 

This opens a blank chart. 

 

3. Select EIS Simulation > Simulate (use the Model Editor to build or edit the 

model).  

The EIS Model Simulation window appears. 

 

4. Select the saved model, and input parameters for the experiment (frequencies 

and data-point density) and values of all circuit elements. 

5. Click the Simulate button. 
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The simulation appears under new tabs. 

 

This is a simulated Bode plot. 

 

 

This is a simulated Nyquist plot. 
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